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Lesson Two: Create and Modify Tables  
 

1. Go to the Create tab, then click on the Applications Parts drop-down list from 
the Templates Group. Go to Quick Parts and choose Contacts.  
 

 

 
 
 

2. You will be prompted to close any tabs that are open; Click yes, then click 
Enable Content. 

 
You will see that a table was created along with other Objects you might want to 
include in the database. Click on each Object to see what it looks like, then delete 
whatever it is that you don't need. 
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3. Let’s say that we don't need to include any Reports. You can click on the first 
Report, hold down the Shift key, click on the last report, and then press the 
Delete key. 

 

  
 
 

Importing Excel Files 

 
1. Open up a blank database. click on External Data, New Data Source, from file, 

Excel. 
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2. You will then be prompted to locate the file that you want to import. Click on the 
Browse button and double-click on the file.  Click OK and then you see the 
worksheets that are on the file. Let’s start with the first one, which is Employees.  
 

 

 
 
 
 

3. Click Next, and let’s check off where it says, “First Row Contains Column 
Headings”. You will then be given the option to make any changes to the Field 
Headings.  

 

 
 
 
 

4. Let’s keep the current settings and click “Next”. You will then be asked about 
creating a Primary Key, which is something that uniquely identifies each record 
in the Table. For this database, let us use a Primary Key that will be created for 
us, because each record will be uniquely identified by a number. Click “Next”. 
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For this database, we don’t need to save the steps so click on “Close”. 
 

5. Double click on “Employees” to open the Table; and you'll see all the entries. 
Right now, the Tables is in what is called Datasheet View.  

 

 
 

6. When you go to the Home tab, and then click on “View”, you will see another 
option called Design View.  

 

 
 
 

This allows you to add more Fields and control the way the records are formatted by 
assigning was called a Data Type. 
 

7. Click on the Data Type next to the phone number. Each Data Type can be 
customized using options under what is called “Field Properties” 
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8. We can then click on what is called an Input Mask, which allows you to apply a 
format every time a record is entered into the database under that Field.  We 
can click on the ellipsis next to the Input Mask and you will see a phone number 
input mask. Click Finish. 

 

 
 
 

 
 

Lesson 3: Create Queries and Export Files to Excel 
 
 

1. Go to the Client Table, then click on the Create tab and choose Query Wizard 
from the Queries Group. Choose Simple Query. 
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2. From the Query Wizard dialog box, choose First Name, Last Name and e-mail 

address. 
 
 

  
 
 

3. Click Next and rename the Query, “Client Emails”; then click Finish. 
 

 
 
 
Let’s expand the column so it is easier to see. Save it, then close all the tabs. 
 

4. Click on the Client Table, then click on Design View. 
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5. In Data Type, use the down arrow to change it to Hyperlink. Then right-click on 
the Clients tab and save it; then close it. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Exporting data to Excel 

 
6. Double-click on the client mailing address Query, click on the External Data tab, 

and choose Excel under Export. 
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7. Under “Specify the file name and format”, choose a location for where you want 
the file to be exported to. In this example, the file location is already selected. 
Under “Specify export options”, check off the “Export data with formatting and 
layout” and the second option that opens up the file after it has been exported; 
click OK.  

 

 
 
 

Lesson 4: Create a Form 

 
 

1. Double-click on the Employee Table. Click on the Create tab and go to the Form 
Wizard. 
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2. Click on the two arrows to select all the Fields, then click Next. 
 

 
3. Keep the first layout option, then click Finish. 
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4. Another way to create a Form is to click on the Table and then choose one of 

the templates. Go to More Forms and click on “Split Form” 
 

  
 
 

5. You can see that this template creates a form that shows you one record at a 
time; and also shows the entire table. When you click on each record, it is 
displayed in the form. Right-click on the Form icon, and then click Save. Name 
the form “Enter Employee Data”. 
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6. Let’s look at another way to create a new Form. Double-click on the clients Tab, 

and from the view down arrow choose Design View.  

 
 
 

7. Click on the blank space under 
Field Name and type in the 
word, “Notes”. Press the Tab 
key, and under Data Type 
choose Long Text and that 
gives us a new Field. Anyone 
that wants to use the form to 
type in notes, or copy and paste 
text from another application 
has a space to do it.  

 
 

8. Right-click on the clients Tab and click Save. 
 
 

9. Click the top portion of the View button to go back to the Data Sheet view.  
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10.  Go to the Create t ab and choose Blank Form 

 

 
 
 

11. This opens the Form Layout View. Click on “Show All Tables” under Field List 
 

 
 
 
  

12. Click on the plus sign next to the Clients Table; then click on the first name and 
then move into the upper left corner. 
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13. Move the last name next to the first name. Repeat the steps to finish completing 
the Form. 

 

 
 
 

14. After you finish adding the rest of the contact information you can left click on 
the place holders, use the mouse to adjust the spacing between the fields. 

 

 
 
 

15. Add a Notes field and place it right underneath the social security number. 
 

 
 
 

16. Make the space for the Notes wide 
enough, so that the user can type in 
notes or copy and paste text from 
another application. Click on the first 
placeholder, hold down the shift key, 
then click on the other two 
placeholders.  
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17. Right-click and choose Merge. 
 

 
 

18. Then position the mouse over the lower right corner and then move it down to 
make it longer 

 

 
 
 

19. Let’s now add something called Command Buttons. First, make sure that the 
Select button is activated. Then click on the down arrow in the Controls group.  
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20. Make sure that the Use Control Wizards button is activated. You will know it is 
active when you see the button shaded and highlighted in red. 

 

 
 
 

21. Click on the Button in the Controls group, then position the Button icon just 
above the Notes Field.  

 

 
 

 
22. The Command Button Wizard will open. Under Categories, click on Record 

Operations. Under Actions, click on Add New Record if it is not already 
selected. Click on Next. Choose the option to display text and then choose 
Finish.  
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23. Repeat these steps to add a command called, “Go to Previous”. Let’s use a 

picture instead of text for the Command button; click Finish. 
 

 
 
 

24. Let’s add space for two new buttons by clicking on the placeholder, right-click 
and choose “Split Horizontally” under Merge and Split. 

 

 
 
 

25. Add two more buttons. One for Go to Next Record; and another one for Find 
Record. You can continue to add additional buttons as needed. Here is what the 
Form looks like with a total of eight buttons: 
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Lesson Five: Create and Modify Reports 
 

1. Click on the Clients Table, then click on Create. Go to the Reports group and 
click on Report Wizard. 

 

  
 
 

2. Double-click on Last Name, First Name, Home Phone and E-Mail Address; click 
Next. 

 

  
 

The Report Wizard gives you the option to organize the data into groups, which is not 

something we need to do for this report; click Next. 
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3.  You have the option to sort the data in ascending order which of the A-Z; 
choose Last Name. Click “Next”. 

 
4. Choose a tabular layout option; click Next. Click Next again, then click on 

Finish. 
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5. From here, you can see what the report will look like as a printed document. 

Click on the Close Print Preview button. 
 

 
 
 

6. Click on the View button down arrow and choose Layout View.  
 

  
 

7. This view allows you to change the positioning of the columns. Click on the Last 
Name column heading, hold down the Shift key, and then click on one of the 
names in the Column (Brideau, for example) and then use your mouse to 
reduce the width of the column by moving it to the left. 
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8. Repeat these steps to adjust the width of the remaining three columns, so that it 
looks similar to this: 

 
 

 
 

9. Let’s create a new table by going to the Create tab, go to Application Parts 
and under Quick Start, click on Tasks. 
 

 
 

10. Click on Enable Content. Double-click on the TaskDetails form 
 

 
 
  

9 



MIS 220 Database Design using Access Page 23 of 38 

11. Click on the Home tab. Click on the View down arrow, then click on Layout 
View. 

 

  
 

 

12. Go to the Description field, and make it a little longer by clicking on the lower 
right side and using your mouse to move the line downward. 
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13. Let’s create a report that summarizes all of the projects. Click on the Create tab. 
With the Report Layout tools tab selected, click on Blank Report and choose 
Portrait. 

 
 

14. Click on “Show all tables”, then click on the plus sign and let’s add Task Title, 
Description, Priority, Start Date and Due Date. 

 

 
 
 

15. Position a mouse to the right side of the description and make it a little wider. 
Make sure that all the fields are still inside the border. 
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16. Click on Report Layout Design, then click on Title;  and let’s name it “Project 
Report” 

 

 
 
 

17. Click on the place holder on the right side of the report, then click on Date and 
Time. Check off the second option under Time; click Ok. 

 

 
 

18. Close the Field List, then click on Property Sheet. 
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19. Click on Sort AZ under Format, then click just outside the Report and make sure 

you see “Detail” under Section Type.  

 
 
 

20. Then click on the Format tab. Under Alternate back color, choose “No Color”. 
Close the Property Sheet. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

21. Then click on the View Tab to go back to Datasheet View. Then right-click on 
the Report tab and click Save. Let’s name it “Project Report”. Close the report. 
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22. As you input new entries and make changes using the Project form, the report 
will also reflect those changes after you open it and click on “Refresh All”. For 
example, we can change one of the due dates on the Form and then save it. 
When we go back to open the Report, we can click on Refresh All, and see that 
due date change made on the report: 

 

  
 

Exporting a Report 

 
1. To export the report as a PDF file, click on the external data tab. Click on PDF 

or XPS from the Export group. 
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2. Choose a file location in this case. For this example, let’s choose “Open File 
After Publishing”. Let’s choose “Standard” and then click “Publish”. 

 

 
   
 

3. To export the report as a text file, you would click on “Text File” under Export. 
Change the file name, keep the same file location and checkoff where it says, 
“Open the destination file after the exports been completed”. Click Ok. 

 

  
 

4. Keep the default setting under “Encode ‘Project Report’ As”; click OK. 
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The Report will open in the Windows Notepad application.  
 

 
 

Access Project: Create a Database with Table Relationships 

 
In this lesson we are going to create an access database that includes something 
called “Relationships”. A Relationship means that records in one Table can be used to 
automatically populate the records in other Tables. 
 

1. Click on the Customer Order Table and go to Design View. 
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2. Let’s add another Field 
that will multiply the price 
times the quantity 
ordered. Type the words 
“Total Order”, then go to 
the Data Type drop down 
and choose the 
“Calculated” Data Type. 

 
 
 
 
 
 
 
 
 
 

3. This will open what’s called Expression Builder, which is used to input formulas 
that perform calculations. Double-click on price input an asterisk and then 
double-click on Quantity; click OK. Save the Table and then close it. 
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4. Let’s click on the Database Tools tab and choose Relationships 
 

  
 

5. Click on Customer Name in the Customer data table. Then use the mouse to 
create what’s called a Join Line between the two customer name fields. The 
Edit Relationship dialog box will appear. Check off where it says, “Enforce 
Referential Integrity”, which means that you’re protecting the relationship 
between the two fields. By enforcing referential integrity, you are saying that the 
record in one Table will always have an associated record in another Table. 
Click on Create. 
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6. You will see that a Join Line appears, which indicates a one-to-many 
relationship. In other words, the customer information Table can only have one 
unique customer name in the Table; this is called the Primary Key. The Order 
Table, however, can have many customer names; and the same customer 
name can appear multiple times. This is referred to as the Foreign Key. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Click on the Close button, then double-click on the Customer data table. You 
will see that there is a plus sign next to each name. And when you click on it, 
the information from the Order table will appear. 

 

 
 
 

6. To see how this works, input the following data under the name “Alisha 
Slusarski”. When finished, click on the minus sign, and then save the Table. 
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Create a Query 

 
7. A Query is an Object that can display a summary of information from one or 

more tables. Click on the Customer Data Table, then click on the Create tab; 
click on the Query Wizard. 

 

 
 

8. The New Query dialog box will appear. Choose Simple Query and then click 
OK. Under Available Fields, choose all the fields from the Custom Information 
table by clicking on the two right arrows.  

 
 

 
 
 
 

9. Click on the Tables Queries down arrow. Choose the Customer Orders table.  
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10. Choose all the fields except for the Customer Name field by either clicking on 

the right arrow to select each field or we can double-click on each name. When 
finished, click the Next button twice.  

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

11. Keep the default name, which is “Customer Data Query” and click Finish. 
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Create an Order Form  

 
1. Click on the Customer Data Query, then click on the Create tab; click on Form 

Wizard. 
 

 
 

2. Click on the two arrows to select all the fields and then click Next. Let’s keep the 
option to create a subform. This means that one form will be used to input the 
customer data and the other form, which is a subform, will be used enter the 
order. Click next. 
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3. Use Datasheet as the subform layout; click Next. Let’s keep the default names 
and click Finish.  

 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
The Form will now show the two areas where data can be inputted. 
 
 

 
 
 

4. Click on the Total Orders Subform, then click on the last row. Click on the Home 
tab, then click on the Totals button for the Records group.  
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5. Click on a space under Total Order and choose Sum. 
 

 
 
And now the total will be calculated each time a new order is entered. You can repeat 
these steps to create a total row for the Customer Information Form. 
 

Create an Order Entry Report 

 
1. Click on the Customer Data Query. Click on Create, then click on Report in the 

Reports group. 
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2. After the Report appears, you can switch to the Layout view to adjust the 

formatting. 
 
 
 
 
 
 
 
 
 
 


